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Abstract
Numerous somatic mutations occurring in the epidermal growth factor receptor (EGFR) family (ErbB) of receptor tyrosine kinases (RTK) have
been reported from cancer patients, although relatively few have been tested and shown to cause functional changes in ErbBs. The ErbB
receptors are dimerized and activated upon ligand binding, and dynamic conformational changes of the receptors are inherent for induction of
746
750
downstream signaling. For two mutations shown experimentally to alter EGFR function, A702V and the Δ ELREA deletion mutation, we
illustrate in the following protocol how molecular dynamics (MD) simulations can probe the (1) conformational stability of the mutant tyrosine
kinase structure in comparison with wild-type EGFR; (2) structural consequences and conformational transitions and their relationship to
observed functional changes; (3) effects of mutations on the strength of binding ATP as well as for binding between the kinase domains in the
activated asymmetric dimer; and (4) effects of the mutations on key interactions within the EGFR binding site associated with the activated
enzyme. The protocol provides a detailed step-by-step procedure as well as guidance that can be more generally useful for investigation of
protein structures using MD simulations as a means to probe structural dynamics and the relationship to biological function.

Introduction
The human epidermal growth factor receptor (EGFR) family (ErbB) of receptor tyrosine kinases (RTKs) includes four members - EGFR/ErbB1/
HER1, ErbB2/HER2, ErbB3/HER3 and ErbB4/HER4. The ErbB receptors regulate fundamental cellular processes such as cell growth and
1,2
proliferation, differentiation, migration and survival , and are thus potent proto-oncogenes. Aberrant activity of the ErbB receptors, especially
2,3
EGFR and ErbB2, has been frequently associated with human cancers making ErbB receptors key targets for cancer therapeutics .
3,4,5

Several somatic alterations of ERBB genes have been reported from human malignancies
. The best characterized examples include the
recurrent, activating point mutations and short in-frame deletions in the EGFR kinase domain in non-small cell lung cancer (NSCLC). These
6,7,8
EGFR mutations represent key drivers of cancer growth, and predict sensitivity to EGFR targeting cancer drugs
. However, in most cancers,
somatic mutations in EGFR occur outside of these recurrent "hotspots" and are distributed over the entire 1210-residue span of the receptor.
9
Indeed, most of the residues along the EGFR primary sequence have been found to be mutated in human cancer . Nevertheless, apart from the
few hotspots, the functional significance of the vast majority of the cancer-associated EGFR mutations remains unknown.
The monomeric structure of ErbBs consists of a large amino terminal extracellular domain, followed by a single transmembrane helix leading
to the intracellular tyrosine kinase domain and C-terminal tail region that contains docking sites for intracellular signaling proteins. Ligand
binding triggers a dramatic conformational change in the extracellular domain, which facilitates the formation of receptor dimers by exposing the
dimerization arms that symmetrically cross over each other and interact with their aromatic/hydrophobic surfaces. Upon receptor dimer formation
the tyrosine kinase domains come into contact asymmetrically (Figure 1), resulting in the activation of the kinases that phosphorylate the C10,11
terminal tails of the receptor monomers, and subsequently in activation of downstream signaling
.
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Figure 1: Structure of the EGFR dimer. EGFR dimerizes when the extracellular domains bind growth factor (EGF, epidermal growth factor).
The receiver kinase domain is then activated through asymmetric interaction with the activator kinase domain, and the C-terminal tails are
12
autophosphorylated at tyrosine residues (Modified from Tamirat et al. ). Please click here to view a larger version of this figure.
Because of the dynamic structural rearrangements that occur during the monomer dimer transitions, along with kinase activation that is
associated with the formation of an asymmetric dimer, mutations along the full length of the receptor structure can potentially have an effect
on receptor function. Here we describe several examples from our previous studies in which modeling of the mutation and visualization were
sufficient to explain the consequences for function.
13

14

Example 1: One reported mutation, D595V in ErbB4 , led to increased ErbB4 dimerization and phosphorylation . Visualization of the location
of the mutation was a critical factor in understanding the observed functional effects: D595V occurred at the symmetrical crossover of the dimeric
arms of the ectodomain (Figure 2A). The arms are largely aromatic and hydrophobic, and the replacement of polar aspartic acid by valine would
be expected to increase the "sticky" hydrophobic interactions, stabilizing the dimer and hence increase the length of time when phosphorylation
14
takes place . It was a surprise at first to find aspartate in each arm, but in retrospect one might think of it as a timing mechanism for activity,
where the polar acid side chains reduce the affinity and lifetime of the intact dimer and hence limit kinase-mediated phosphorylation and
signaling. Replacement by valine would then remove this safeguard by further stabilizing the ErbB4 dimer.
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Figure 2: Location of an ErbB4 activating mutation and mutations producing kinase-dead ErbB4. (A) D595 (activating D595V mutation)
is located on the aromatic/hydrophobic dimeric arms of the ErbB4 ectodomain model; the arms associate on growth factor binding; (nearby
residues are shown as sticks). (B) In ErbB4, G802 (inactivating G802dup mutation) helps form the binding pocket around the adenine ring of ATP
2+
and catalytic D861 (inactivating D861Y mutation) binds both Mg (not shown) and the γ-phosphate group of ATP. Please click here to view a
larger version of this figure.
Example 2: One might anticipate that somatic mutations that target the ATP-binding site of the kinase domain would alter or eliminate enzymatic
activity leading to an impaired or kinase-dead receptor incapable of signaling. Of nine reported mutations from patients with breast, gastric,
15
16
colorectal, or NSCLC , two of the nine mutations when tested had highly diminished phosphorylation activity : G802dup (G → GG) and
D861Y. Both inactivating somatic mutations were found within the ATP binding site of the tyrosine kinase domain structure (Figure 2B): flexible
glycine, duplicated, would alter the adenine ring site and small aspartic acid replaced by the bulky tyrosine near the terminal phosphates would
2+
physically prevent Mg -ATP from binding. However, since ErbB4 can form a heterodimer with ErbB2 - ErbB2 does not bind a growth factor and
depends on association with an ErbB that does in order to heterodimerize - the ErbB2(active)-ErbB4(kinase-dead) heterodimer would stimulate
cell proliferation via the Erk/Akt signaling pathway yet cells would not differentiate because of kinase-dead ErbB4 and lack of STAT5 pathway
16
activation .
In more recent studies, it became apparent that the dynamic movements of ErbBs were relevant to understanding the effects of some mutants
on ErbB function, especially mutations that occur within the tyrosine kinase domain. The tyrosine kinase domain consists of an N-lobe (mainly
β-sheets) and C-lobe (largely alpha helical), which are separated by the catalytic site where ATP binds. The N-lobe includes the αC helix and
17,18,19
P-loop, whereas the activation (A-loop) and catalytic loops are present in the C-lobe
. Crystal structures of the tyrosine kinase domain
revealed two inactive conformations, the majority of structures have the Src-like inactive state. In the active conformation the catalytic aspartate
of the A-loop points towards the ATP binding site and the αC helix is oriented towards the ATP binding pocket ("αC-in" conformation), forming a
strong glutamate-lysine ion-pair interaction.
Because ErbBs and the component kinase domain are highly dynamic entities, and especially for instances where the effects of mutations on
function and biological activity are likely to be tightly linked to the conformational states of the ErbBs, it is important to assess mutations with
respect to the range of dynamic changes they would experience. X-ray crystal structures of ErbBs provide static snapshots of the 3D structure,
which may or may not be relevant to understanding the dynamic consequences of a mutation. In order to probe the range of dynamic changes
corresponding to the "energy landscape" available to a three-dimensional (3D) structure, molecular dynamics (MD) simulations are widely
20
used . In the case of mutations that would lead to local conformational changes within the tyrosine kinase domain or stabilization of a complex,
simulations on the order of 100 ns may be sufficient. However, larger scale conformational changes (e.g., transitions between the active and
21
inactive conformations of the kinase domain) require a longer simulation time - on the order of microseconds .
With respect to the protocol described below we consider two activating mutations within the tyrosine kinase domain (Figure 3). Both mutations
are located within the kinase domain at locations that experience local conformational changes that dictate whether the kinase is active or not,
and thus MD simulations were applied in both instances. In the first case, we consider changes that directly affect the ATP binding site and
catalytic machinery of the EGFR receiver kinase domain, specifically examining the consequences of an exon 19 deletion mutation that is widely
4,7
746
750
implicated in NSCLC . The Δ ELREA mutation, which reduces the length of the β3-αC loop preceding the αC helix - the helix that moves
towards the binding/active site on kinase activation and participates in forming the critical electrostatic interaction between E762 of the helix and
12
K745 by positioning the lysine for interaction with ATP - predisposes the domain for activation . In the second case, we consider the A702V
9
mutation of EGFR, shown to be a novel gain-of-function activating mutation revealed by the iScream platform and identified in an NSCLC
22
patient . Alanine-702 on the receiver kinase domain is located on juxtamembrane segment B at the interface of the receiver and the activator
9
kinase domains, in which this asymmetric kinase dimer complex and kinase conformational changes are required for activation .
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Figure 3: The asymmetric kinase domain dimer of EGFR. The A702V mutation would be located at the critical interface of the activator
and receiver kinase domains, adjacent to the αC helix and close to isoleucine 941 of the activator kinase. Conformational changes induced by
formation of the asymmetric dimer lead to kinase activation. The β3-αC loop containing the ELREA sequence directly precedes the αC helix;
during activation, the αC helix moves inward towards the ATP binding site. Please click here to view a larger version of this figure.

Protocol
NOTE: The detailed steps taken to examine the effects of the ΔELREA and A702V mutation on the EGFR structure using MD simulations are
discussed as follows:

1. Structure preparation
NOTE: In order to study the structural impacts of the ΔELREA mutation, wild-type and mutant forms of apo active, ATP-bound active and apo
inactive EGFR monomer structures are prepared as follows.
23

1. Open the Chimera visualization program (https://www.cgl.ucsf.edu/chimera/) to prepare the wild-type apo active EGFR kinase structure.
24
25
In the File menu click the Fetch by ID option and select the Protein Data Bank (PDB ) database and specify PDB code 2GS2 (2.8 Å
resolution). The PDB is a repository for 3D structures solved by different experimental techniques, including X-ray crystallography, nuclear
magnetic resonance spectroscopy, cryo-electron microscopy and neutron diffraction.
26
27
2. Build the missing structural elements of 2GS2 by taking these segments from the EGFR PDB structures 1M14 (2.6 Å) and 3W2S (1.9
Å). To do so, open 1M14 and 3W2S and superimpose them on 2GS2 using the MatchMaker option in the Tools → Structure comparison
menu.
1. Crop out the segments to be added from 1M14 and 3W2S. Select the terminal atoms of the residue before the gaps in 2GS2 and the
atoms to be added from 1M14 and 3W2S (for detailed information on the added segments, see Table 1). On the command line type
bond sel and hit enter. This structure is the template structure.
3. Use the template structure from step 1.2 to construct the ΔELREA deletion mutant form of the EGFR kinase domain. Produce the FASTA
format sequence of ΔELREA EGFR by saving the sequence of the template structure (Favorite → Sequence → File → save as) and then
deleting the ELREA sequence at residue numbers 746-750.
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1. Open the ΔELREA EGFR sequence in Chimera and align it with the sequence of the 2GS2 template structure using the Sequence
28
menu. In the alignment window select the Structure → Modeller (homology) option.
2. On the pop-up window specify the 2GS2 composite structure as the template and the mutant sequence as the query to be modeled.
Then press OK. Select a mutant model among the resulting models, based on the zDOPE score (typically the lowest score) and visual
inspection.
29

4. To prepare the ATP-bound wild-type EGFR kinase structure, use PDB structure 2ITX (2.98 Å) as the principal structure. Build missing
25
segments (see Table 1) using the structures 2GS6 (2.6 Å) and 3W2S following the procedure in step 1.2. Convert the ligand ANP in the
resulting structure to ATP by opening the PDB file in a text editor and changing the N3B nitrogen atom of ANP to an oxygen atom.
29
5. Open the structure in step 1.4 in Chimera as stated in step 1.1. Add a magnesium ion to this structure from PDB structure 2ITN (2.47 Å) in
2+
order to attain a similar positioning for the Mg ion.
6. With the structure resulting from step 1.5, model the ΔELREA mutant form following the step 1.3.

Principal structure

Apo active EGFR

Apo inactive EGFR

ATP-bound active EGFR

2GS2

2GS7

2ITX

3W2S (958-984)

2GS6 (862-865)

4HJO (848-850)

3W2S (990-1001)

Structures used to build missing 1M14 (723-725)
loops
3W2S (967-981)

Table 1: Structures used to build composite models of apo active, apo inactive and ATP-bound active structures. Missing regions (amino
acid range in parentheses) in the principal structure were constructed from the listed structures.
25

7. To prepare the wild-type apo inactive EGFR kinase structure, open PDB structure 2GS7 (2.6 Å) as in step 1.1 and delete the bound
30
ligands and crystallographic waters. Add the missing segments in 2GS7 (see Table 1) from structures 3W2S and 4HJO (2.75 Å) using the
procedure in step 1.2. Based on the final inactive EGFR structure, prepare the mutant model using the procedure in step 1.3.
NOTE: For the A702V mutation study, the EGFR asymmetric dimer structure is studied as the mutation is located at the juxtamembrane B
segment of the kinase domain that forms a large part of the dimer interface. The wild-type and A702V mutant EGFR structures are prepared
as follows:
8. The wild-type asymmetric dimer structure is constructed from PDB structure 2GS2, which initially is displayed in the monomeric form. To
convert to the biological assembly that contains the activator and receiver kinases in the asymmetric arrangement, open 2GS2 in Chimera as
in (1.1) and carry out symmetry calculations by clicking the Tools → Higher-Order Structure → Unit Cell menu. Select the 2GS2 structure
and enter Make copies. Finally, select and save a single asymmetric dimer from the multiple copies of the dimer resulting from the symmetry
operations.
9. Using the wild-type asymmetric EGFR structure from step 1.8, build the A702V mutant by replacing alanine 702 with valine using the Tools
→ Structure editing → Rotamers option in Chimera.
NOTE: Collectively, six monomeric and two dimeric EGFR structures are prepared for the ΔELREA and A702V mutation studies, respectively.
31
Each structure is subsequently processed for simulation using the protein preparation wizard in the Maestro program and MD simulations
32
are made with the Amber program .
10. Open the structure in Maestro by using the File → import structure option. Then click on the protein preparation wizard button and
select the following: add hydrogen atoms, build missing side-chain atoms, determine protonation states of ionizable residues at pH 7.0 using
PROPKA, optimize the orientation of asparagine, glutamine and histidine residues for hydrogen bonding, and finally minimize the structure.

2. System setup
33

1. Open the leap program included in the Amber software package. Import the ff14SB force field (source leaprc.protein.ff14SB) and
34
35
TIP3P water molecules (source leaprc.water.tip3p). For the ATP-bound systems also import parameters for ATP (loadamberparams
frcmod.phosphate, loadamberprep ATP.prep). Then, load the structure (mol = loadpdb structure.pdb).
2. Solvate the structure in an octahedral box with explicit TIP3P water molecules that extends 10 Å in all directions from the surface atoms of
the protein (solvateoct mol TIP3PBOX 10.0).
3. Check the built system (Check mol) and neutralize it by adding necessary ions (addions mol Na+ 0). To sufficiently model biomolecular
+
systems, add additional Na /Cl atoms to the simulation box to bring the system salt concentration to 0.15 M (addions mol Na+ X, addions
mol Cl- X), where X is replaced by the result of: desired salt concentration * number of water molecules * volume per water molecule *
Avogadro's number.
4. Generate and save the topology and coordinate files of the system, which serve as inputs for the subsequent production simulation
(saveamberparm mol X.prmtop X.inpcrd).

3. Molecular dynamics simulation
1. Using Amber, initially subject the simulation system to 5000 cycles of steepest descent and conjugate gradient energy minimization to
circumvent unfavorable configurations. Carry out the minimization in multiple steps, gradually lowering the restraint applied on solute atoms
-1 -2
-1 -2
from 25 kcal mol Å to 0 kcal mol Å .
1. In the minimization input file, min.in, adjust the maxcyc variable for the total minimization cycle (maxcyc = 5000) and ncyc to state
the number of cycles for the steepest descent algorithm. Use the restraint_wt variable to apply the restraint force on solute atoms
specified by the restraintmask parameter. Then run the minimization as follows:
$AMBERHOME/bin/sander -O -i min.in -o min.out -p X.prmtop -c X.inpcrd -r min.rst -ref X.inpcrd
NOTE: The strategy and actual parameters used may vary according to one's own preferences. Details and guidance can be found
from the Amber manual and website (https://ambermd.org/index.php)
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2. Heat the system for 100 ps from 0 K to 300 K setting a 10 kcal mol Å restraint on solute atoms. To do so, set tempi = 0.0, temp0 = 300.0,
dt = 0.002 ps, nstlim = 50000 and restraint_wt = 10 in the heat.in input file. Carry out the heating with the following command:
$AMBERHOME/bin/sander -O -i heat.in -o heat.out -p X.prmtop -c min.rst -r heat.rst -x heat.mdcrd -ref min.rst
3. Equilibrate the system for 900 ps under an NPT ensemble; constant number of atoms, temperature (temp0 = 300.0) and pressure (ntp =
1), controlling it with the Berendsen method (ntt = 1). Set a 9 Å distance cutoff (cut = 9.0) for long range electrostatic interactions. Gradually
-1 -2
lower the solute atom restraint to 0.1 kcal mol Å (restraint_wt = 0.1). Run the equilibration input file equil.in that describes the above
parameters as follows:
$AMBERHOME/bin/sander -O -i equil.in -o equil.out -p X.prmtop -c heat.rst -r equil.rst -x equil.mdcrd -ref heat.rst
4. Finalize the equilibration with an unrestrained 5 ns simulation (set dt = 0.002 ps, ntslim = 2500000).
$AMBERHOME/bin/sander -O -i equil_final.in -o equil_final.out -p X.prmtop -c equil.rst -r equil_final.rst -x equil_final.mdcrd -ref
equil.rst
5. Check that the system has equilibrated by examining the temperature, pressure, density and energy values.
$AMBERHOME/bin/process_mdout.perl heat.out equil.out equil_final.out
xmgrace summary.TEMP/DENSITY/ETOT/EPTOT/EKTOT
6. Carry out the production simulation for 100 ns (set dt = 0.002 ps, ntslim = 50000000 in prod.in) and save conformations every 10 ps (ntwx
= 5000).
$AMBERHOME/bin/sander -O -i prod.in -o prod.out -p X.prmtop -c equil_final.rst -r prod.rst -x prod.mdrcd -ref equil_final.rst

4. Analysis
1. Visual inspection
1. Visualize the conformations sampled during the wild-type and mutant EGFR kinase simulations by opening the X.prmtop amber
36
topology files and the corresponding prod.mdcrd trajectory files in VMD . Using convenient secondary structure representations,
analyze the overall structural dynamics of the proteins from the recorded trajectory. View specific interactions between atoms/residues
of interest, such as the catalytically essential K745 - E762 salt bridge.
2. Alternatively, save multiple conformations sampled during the simulation in PDB format and open them using the Chimera program.
Superimpose the structures on the initial or median structure using the MatchMaker option. Display the initial/median structure in solid
and the rest of the aligned structures in faded white. This approach allows one to visualize the recorded structural movements with
more clarity.
NOTE: Suggestions for effective representations and processing of conformational ensembles from MDS can be found in Melvin et
37
al. .
2. RMSD and RMSF analysis
38
1. Compute root-mean square deviation (RMSD) and root-mean square fluctuation (RMSF) calculations with the Cpptraj program to
analyze the global stability of the proteins and examine the flexibility of the different structural units. In the rmsd.in and rmsf.in input
files, indicate the backbone atoms (for RMSD) and Cα atoms (for RMSF) of the initial structure as the reference for RMS fitting. In the
rmsd/rmsf.in files import the amber topology files (parm X.promtop) and the corresponding trajectory files (trajin prod.mdcrd). Then
run the command Cpptraj -i rmsd/rmsf.in. Plot the output data for analysis.
2. Alternatively, align conformational ensembles and color each residue based on the Cα atom RMSD. To do so, open the conformations
in Chimera and align them with Matchmaker option.
1. Go to Tools → Depiction → Render by attribute. Select Residues of the conformational ensemble and Cα RMSD as the
attributes and click OK. The chain trace of the conformations will then be colored from blue → white → red, respectively
reflecting regions of high, medium and low structural stability.
3. Hydrogen bond analysis
1. Analyze the hydrogen bond interaction between ATP and wild-type/ΔELREA EGFRs. Prepare a Cpptraj script, hbond.in, to carry out
this task. Define a hydrogen bond with a donor-acceptor distance of less than or equal to 3.5 Å and a bond angle of greater than or
equal to 135°. Specify analysis only for intermolecular hydrogen bonds with the nointramol variable i.e. hydrogen bonds between ATP
and EGFR (hbond All nointramol dist 3.5 out nhb.agr avgout avghb.dat). Run the script as Cpptraj -i hbond.in.
2. Use this script to assess intramolecular interactions, for instance between residues K745 and E762, which are key residues for EGFR
kinase activity. To do so, specify K745 as the hydrogen bond donor and E762 as the hydrogen bond acceptor in hbond.in and run the
script accordingly.
4. Monitoring distance between atoms
1. Measure the distance between K745 and E762 by opening the trajectories of wild-type and ΔELREA apo EGFRs in VMD. Select the
Cδ of Glu762 and Nz of Lys745 by clicking Mouse → label → bond. Monitor the distance during the simulation by plotting a graph with
graphics → labels → bond → graph.
5. Free energy calculations
1. To compute the estimated binding free energies between ATP and wild-type/ΔELREA EGFRs, and between the activator and receiver
39
kinases of wild-type/A702V EGFRs, use the molecular mechanics generalized Born surface area (MM-GBSA) module available in
the AMBER package. Set ATP as the ligand and EGFR as the receptor in the ΔELREA study. In the A702V study, specify the receiver
kinase as the ligand and the activator kinase as the receptor.
2. First prepare the ligand, receptor and ligand-receptor complex PDB files separately in the leap program setting the PBRadii value to
mbondi2. For the PDB files, save the gas phase amber topology (.prmtop) and coordinate (.inpcrd) files.
3. Then, in the mmgbsa input file, mmgbsa.in, set igb = 2, saltcon = 0.1. Execute binding energy calculations using the trajectories of
the simulations, the prepared receptor/ligand amber files and the parameters in the mmgbsa.in with the MMPBSA.py script available
in Amber as follows:
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$AMBERHOME/bin/MMPBSA.py -O -i mmgbsa.in -o mmgbsa.dat -sp X.prmtop -cp complex.prmtop -rp receptor.prmtop -lp
ligand.prmtop -y prod.mdcrd -eo output.csv
4. Analyze the output data, output.csv, by plotting graphs.

Representative Results
The described protocol was used to study the structural effects of the ΔELREA and A702V mutations on the EGFR kinase structure. One
application of the protocol was to investigate the effect of the mutations on local structural/conformational stability by computing RMSD and
RMSF values from the MD simulations. As the A702V mutation is located at the juxtamemembrane B segment, the RMSD of this segment of
the receiver kinase relative to the starting structure was calculated for both the wild-type and A702V EGFRs. The result (Figure 4A) revealed
that the juxtramembrane B segment of the mutant has increased conformational stability during the 100 ns simulation (average RMSD 0.7 Å 95% confidence interval (CI) 0.009) as compared to the wild-type EGFR kinase domain (average RMSD 1.1 Å - 95% CI 0.01). This is very likely
the result of the tighter hydrophobic interactions at the dimer interface due to replacement of alanine 702 (methyl group side chain) to a bulkier
hydrophobic residue, valine (isopropyl group side chain), leading to increased hydrophobic interactions of V702 on the receiver kinase domain
with isoleucine 941 of the activator kinase domain.
The ΔELREA mutation is located at the β3-αC loop, adjacent to the functionally critical αC helix; the conformation of the αC helix is key to shifts
between the active and inactive states of the EGFR kinase. The conformational stability of the αC helix in the active state was assessed by
examining the RMSF over the Cα atoms of residues within the helix during MD simulations (Figure 4B): overall, there are lower fluctuations in
the mutant (average RMSF 1.1 Å - 95% CI 0.4) in comparison to the wild-type (average RMSF 1.5 Å - 95% CI 0.57); with the highest difference
in fluctuations recorded for the N-terminal residues. The sampled conformations respectively superposed on the median structure of the wildtype kinase domain and of the ΔELREA kinase domain also support these results (Figure 4C): both the wild-type and ΔELREA kinase domains
have overall similar stability for the superposed conformations except for the β3-αC loop and the αC helix, which are clearly more stable in
ΔELREA EGFR. These findings indicate that deletion of the ELREA sequence restrains the movement of the active state αC helix, hence
restraining and thus stabilizing the active conformation. Furthermore, since the αC helix forms part of the asymmetric dimer interface, the
restraints on the αC helix in the mutant would very likely stabilize the asymmetric dimer, prolonging the duration of the activated state.
Another application of the protocol is to investigate the behavior of key intra- and intermolecular interactions taking place during the simulation.
Thus, the interaction between K745 and E762, which is fundamental to EGFR enzymatic activity, was analyzed for both the active form wildtype and ΔELREA EGFR kinase by measuring the percentage occupancy of hydrogen bonds formed between the side-chain polar atoms of
the two residues during the MD simulations (Figure 5A): this key electrostatic interaction was formed more often in the ΔELREA kinase domain
2+
in comparison to the wild-type kinase domain, owing to the more stable αC helix that accommodates E762. The interactions between Mg ATP and the wild-type and ΔELREA EGFR kinase domains (Figure 5B) during the simulation were also assessed (Figure 5C): the number of
hydrogen bonds were greater for ΔELREA (average value 4.0 - 95% CI 0.03) than for the wild-type EGFR (average value 3.2 - 95% CI 0.04).
Further analysis of the hydrogen bonds revealed that K745 interacts more frequently with the phosphate groups of ATP in ΔELREA EGFR, which
is linked to the more stable K745-E762 interaction noted in the simulation of the ΔELREA mutant EGFR kinase domain.
MD simulations as described in the protocol are also useful in assessing the relative free energy of binding for protein-protein and protein-ligand
interactions. The binding energies between the activator and receiver kinase domains of wild-type and A702V EGFRs, and between ATP and
the wild-type and ΔELREA mutant EGFR kinase domains, were computed from molecular mechanics generalized Born surface area (MMGBSA)
calculations (Figure 6A): the A702V mutant produced a lower average ΔGbind value (average ΔGbind = -76 kcal/mol - 95% CI 0.47), representing
more favorable dimer interactions, in contrast to the wild-type EGFR domain (average ΔGbind = -61 kcal/mol - 95% CI 0.61). This observation
is consistent with the more stable juxtamembrane B segment and tighter dimer interface due to increased hydrophobic interactions observed
for the A702V EGFR kinase domain. In the case of ATP binding to the wild-type and ΔELREA EGFR kinase domains (Figure 6B), MMGBSA
calculations predict stronger ATP binding with the ΔELREA mutant (average ΔGbind -57 kcal/mol - 95% CI 0.43) in comparison to wild-type EGFR
(average ΔGbind -48 kcal/mol - 95% CI 0.33). This outcome is in line with the greater number of hydrogen bonds recorded between ATP and
ΔELREA EGFR (Figure 5C) in comparison to the wild-type domain.
The protocol can also be employed to investigate conformational changes observed during a simulation. In the current study, the effects of the
ΔELREA mutation on the inactive EGFR conformation was studied by visual inspection and superpositioning of the sampled conformations from
the simulation. The analysis uncovered an inward movement of the αC helix in the ΔELREA EGFR kinase domain (Figure 7A), a structural
change expected during the transition to the active state. In contrast, the αC helix of wild-type inactive EGFR maintained its initial conformation
40,41
(Figure 7B). Thus, the MD simulations support the proposal that the deletion mutation, shown experimentally to increase kinase activity
,
promotes a conformational shift from the inactive kinase towards the active state.
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Figure 4: Wild-type and mutant conformational stability of the active EGFR kinase domain during MD simulations. (A) RMSD (backbone
atoms) over the juxtamembrane B segment of the wild-type (blue) and A702V (red) receiver kinase domain. (B) RMSF (Cα atoms) over residues
of the αC helix: wild-type (blue) and ΔELREA (gold). (C) Superposed sampled conformations of wild-type (left) and ΔELREA (right) EGFR kinase
domain; chain traces colored based on RMSD (Cα atoms) of each residue with respect to the median structure. Coloring ranges from blue to
white to red, representing regions of high to low conformational stability. Note that the "free" N-terminal regions of the isolated kinase domain,
9
colored red, would not exhibit this level of mobility in the intact EGFR structure. Figures adapted from Chakroborty et al. (Figure 4A reproduced
12
with permission of the Journal of Biological Chemistry) and Tamirat et al. . Please click here to view a larger version of this figure.
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Figure 5: Key features seen in the active receiver kinase during MD simulations: the K745-E762 salt bridge, the αC helix and
interactions with ATP. (A) Percentage occupancy of the K745-E762 interaction during the simulation of the wild-type (blue) and ΔELREA (gold)
2+
EGFR kinase domains. (B) Residues of the wild-type and ΔELREA mutant interacting with ATP (sticks). Mg (green) coordinates with ATP and
D855. (C) The number of hydrogen bonds formed by ATP with both the wild-type and ΔELREA EGFR kinase domains during MD simulations.
12
Figure from Tamirat et al. . Please click here to view a larger version of this figure.

Figure 6: Lower relative free energies of binding are observed for the mutant kinase domains during the simulations. (A) Binding
energies calculated for the interaction between the activator and receiver kinase domains of the wild-type (blue) and A702V (red) EGFRs. (B)
9
ΔGbind of ATP to wild-type (blue) and ΔELREA (gold) EGFR kinase domains. Figures adapted from Chakroborty et al. (Figure 6A reproduced
12
with permission of the Journal of Biological Chemistry) and Tamirat et al. . Please click here to view a larger version of this figure.
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Figure 7: Superposed conformations from the wild-type and ΔELREA inactive EGFR kinase domain. Conformation of the αC helix and Aloop helix of (A) wild-type (median structure in blue) and (B) ΔELREA EGFRs (gold). Other sampled conformations, faded white; initial structures
12
prior to the MD simulations, pink. Figure from Tamirat et al. . Please click here to view a larger version of this figure.

Discussion
The protocol described in this study focuses on using molecular dynamics simulations to investigate local and global structural alterations
that arise from activating somatic mutations of the EGFR kinase domain. Although X-ray crystal structures of wild-type and mutant EGFRs
provide invaluable structural insight, they depict one or a few static representations. However, inherent to the biological function of ErbBs is
the necessary transitions between the enzymatically inactive and active tyrosine kinase, invoking dynamic changes in both the structure and
intramolecular interactions between kinase monomers. MD simulations were thus carried out to probe the dynamic nature of the EGFR tyrosine
kinase domain, including the wild-type structure, the introduced ΔELREA deletion mutation, and the A702V mutation. These simulations were
successful in elucidating the likely role of these mutations in the structures and how their effects on the conformation of the tyrosine kinase
domain would lead to the experimentally observed increases in EGFR kinase activity.
A crucial step in this protocol is the use of a relevant structure to assess the impact of the mutation. One way to select a relevant simulation input
structure is to visualize the location of the mutation in the static 3D structure and examine its possible impact with respect to the neighboring
amino acids and structural units. In this study, for instance, since the A702V EGFR mutation is located at the juxtamembrane B segment that
forms the asymmetric dimer interface, the use of the dimer structure for the simulation as opposed to the monomer is critical. The use of a
monomeric structure would have exposed the juxtamembrane B segment of the receiver kinase to the solvent, depriving it from the stabilizing
interactions, enhanced by the mutation to a larger hydrophobic residue and interactions with isoleucine 941 from the C-lobe residues of the
activator kinase. Moreover, it is noteworthy that the 3D structure represented by the coordinates in a PDB file do not necessarily correspond to
the biologically relevant structure that should be used for study. For example, with the structure of ErbB4, PDB code 3BCE, the PDB coordinates
correspond to a trimer, but this is due to crystal contacts (few contacts between the monomers are seen when visualizing this structure). Matrices
within the PDB file can be used (e.g., within Chimera) to reconstruct the crystallographically related structures, which can be visualized to identify
42
chains that correspond to the biologically relevant 3D structure as reported in the original publication . Another essential step of the protocol is
to properly prepare the simulation input structure, such as building missing amino acids in different loop regions, and especially where located in
the vicinity of the mutation. Although numerous wild-type EGFR structures exist in the PDB, only a limited number of mutant EGFR structures are
available. Consequently, the mutant structures also need to be modeled; for a single residue mutation like A702V, Chimera was used to mutate
the residue; whereas, for the ΔELREA deletion mutation, Modeller was used.
The various parameters utilized in the simulation input files - for example, the number of minimization cycles, heating the system to the desired
temperature in one go or instead heating slowly through several intermediate temperatures, the time period for the equilibration and for the
production simulations - can be modified based on the molecule of study, the aim of the work and one's own preferences. While carrying out
MD simulations, it is also common to come across errors that can arise from the input files, issues related to the simulation software in use or
even a user error. Hence, it is very important to understand the source of the errors by carefully examining any error messages. Most simulation
programs have a mailing list where users can pose questions to the software developers and to other users by which most problems can be
resolved. Additionally, user manuals provide significant assistance to understanding the details of the simulation protocol, including assumptions
and limitations. Although MD simulation is an important tool to explore the dynamic properties of molecules, remember that computational
results need to be carefully evaluated in conjunction with other sources of information to assess their validity. Whenever possible, work together
with researchers that are experts on the proteins under study, especially where relevant wet-lab experimental studies are made, which serve
to provide results for structural interpretation as well as to suggest experiments that may be made based on structural observations to test
hypotheses.
In this study, the protocol was effective in examining the dynamic structural impacts of the ΔELREA and A702V mutations on the EGFR kinase
structures. The simulations revealed that ΔELREA restrains the functionally essential αC helix and promotes a conformational shift from the
inactive kinase to a stabilized active kinase. The simulation results are independently supported by drug response data that demonstrated the
effects of tyrosine kinase inhibitors on lung cancer cell lines having the ΔELREA deletion mutation and wild-type EGFR, where greater inhibition
12
by drugs recognizing the active kinase conformation was reported for ΔELREA than for wild-type EGFR . With the A702V mutation, the MD
simulations indicate, in comparison to the wild type, increased stabilization of the activator-receiver kinase interface as well as higher affinity of
the activator and receiver kinase for each other, together supporting maintenance of the activated conformation of the EGFR kinase. The A702V
Copyright © 2020 Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported
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mutation, located on the juxtamembrane B segment of the receiver kinase, would increase hydrophobic interactions with the activator kinase,
functioning to prolong the duration of the activated state. The A702V mutation supports cell survival in the absence of growth factor and was
9
identified in an in vitro screening for EGFR mutations .
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